ODOQOT Confidence Point Report

By Kevin LaVerdure, PLS

Overview

This workflow will document the steps to prepare a Confidence Point Analysis Report from an
OpenRoads or OpenSite Designer (ORD/OSD) Terrain using the “Points>Analyze Elevation” tool and the
Custom Report Stylesheets. It will also document the steps to Import the Processed Confidence Point
text file into the ORD/OSD DGN for display and evaluation.

Required
» Project Terrain file (3D). (i.e. S_K99999 TERR e pub_01.dgn)
» Confidence Points for Project, as a separate *.csv data file stored on a local drive/crew network
server share or included with the Survey terrain data imported to the Survey Field Book in the
active DGN.

Project Procedure

This document will be divided into three general sections. The ODOT Confidence Point Report workflow
steps are in sections A and B. Section C contains supporting documentation.

NOTE: It is recommended that all Point Data Files (*.csv), Report Files (*.html), and Processed Point Files
(*.txt) be stored on a non-PW drive, i.e. Local C: drive or other crew server.

A — Generating the report and processed POiNt file. ....ueeeiiiiicciiiiiie e 2
B — Importing the processed data into the Terrain file for analysis. .....ccccecvieeiieiiieiicieee e 11
C — Differences in File Dialog Display With ProjeCtWise. ......cccceiiiiiieeiiniiiessciieec st s e e ssvee e s eevenas 16
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A — Generating the report and processed point file.

1) Open the file that contains the Terrain, (i.e. S_K99999 TERR_ e pub_01.dgn) using ORD/OSD.

2) Import the Confidence Point Data into a Field Book. If the Confidence Point Data has already
been imported or included with the Terrain Data Field Book, then go to Step 3.

a. Create a new Field Book; choose Field Book > Create > New Field Book.

g1 survey o HE R e = h & Workflow Me

File Home Field Book Analyze Edit Terrain Geometry Drawi

Q M Ay Reset Details k s \J x 'y e

Explorer Details Elerment ..., Mew Delete  Mew File
Selection i..0 ¥ [JField Book]Field Book Point

Primary Selection Create

Explorer .
W View 1 - Top,

b. Follow the onscreen prompts to create the new Field Book for importing the Confidence
Point Data, enter a name for the Field Book of ‘Conf_Pnt_Raw’.

New

Field Book Name Conf_Prt_Raw

4 & L] Survey Data
4 v [ Default
4+ [l Field Books
v 1 Matlab_OG
I 4 ' ] Conf_Pnt_Raw ]
o4 % Data Files

MName
Mew:Field Book Name

c. Choose Field Book > Import > File

o HE R e - o = h & Workflow MenuPopUp =  CAODOT\COMNECT._Project:

Field Book Analyze Edit Terrain Geometry Drawing Production Drawing View
Ay Reset Details * ey ] x ¢ el ¥ ¥0 D |

Elernent ... Mew Delete  MNew Text  Trimble Leica Graphics Bentley
Selection i..i 7  Field Book Field Book Point izard Link DBX Survey
mary Selection Create 2
- 01w
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d.

e.

May 2026

Follow the onscreen prompts, Locate Field Book = Conf_Pnt_Raw

4% load Data  — x

Field Book o »~
Locate Field Book | W I

Load L Conf_Prit_Raw
Type DataFile

Navigate to the folder on your local drive that contains the Confidence Point data file (*.csv),

select the data file, and click the ‘Open’ button.

| B selectfile
| &« v [ <« WORK > ORD_Test » Settings Wk > 2026-05_ConfPnt Waorkflow > Data ]ov
Organize *  Mew folder
~
0 Music » Name Date modified Type

Search Data

£ Videos » l [ Matlab_ConfPnt_Orig.csv

1

Microsoft Excel C...

|5 5_K28388 FldDoc_01.csv

Data
{2 SF_ASC_TestMatLab_Test/PT.csv
Werk
[ SF_ASC_TestMatLab_TestIPT_MIXED.csv
ScreenShots
Werkflow_Dec
~ [l ThisPC

27 Windows (C)

5w hwyed6r (wp

.

5/12/2026 10:51 AM

Microsoft Excel C...
Microsoft Excel C...

Microsoft Excel C...

File name:

= - O
Size
3KB ]e
41KB
41KB
35K8
| AnFiles 1)

e I Open I Cancel
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3) Open the Survey Details dialog from the Survey Ribbon Workflow.

4)

Field Book > Primary

> Details.

ﬂ Survey
Home Field Book

'-'.“_t:i rll 1y Reset Details

Explore Details

Prirnary
Explorer

File

¥ Itemns

roHER « -+ £

Analyze Edit Terrain

J

ey
HLH

Elernent ...,

Selection L0 7

Selection

* I %

i

In the Survey section of the Explorer, drill into the Survey Data and expand the “ALL Point

Features” section of the Field Book that contains the confidence points.

4
+=
X

Explorer

i& File
W Items
| OpenRoads Maodel
¥ sheet Index
e Links
| OpenRoads Standards
| Drainage and Utilities Model
i Survey

| Search

52

> |¢i|¢|c|¢|¢|¢|¢e

4 v [ Survey Data
4 v [E Default
4~ [ Field Books
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4 v [ Existing_Data
b '« ¥ Data Files
»
b ¥ L ALL Linear Features
v % ALL Contral Points

el
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5) Within the ALL Point Features section, select the first Confidence Point code that you want to
report on, then while holding the <Ctrl> key, select all other codes that you want to report on.
(CPG, CPN, CPR, CPS) This will display all points with the selected codes in the Survey Details

dialog.

Survey
QWP

| Seanch

4 v [ surveyData
4 v [E Default

4 v [l Field Books
4 ¥ B Existing_Data
b v % DataFiles

4 v 74 ALL Paint Features

<  #'pL
5 pse
~ &% coN

#4' CUR

L 1

NOTE: You can also use the Survey Filters to select the Confidence Points and display them in
the Survey Details if you are familiar with the operation of the Survey Filters.

6) In Survey Details left click, or data point, in the upper left corner of the table to select all points
shown in the Survey Details dialog.
=] Element List B Message Center
? Mame Morthing Easting Elevation Field Code Link Code Description ™
3 i\k:_ ¥ None
Mone
_l‘-lcnne
None
Mone
Mone
| . Mone
191.331° None
06 None
153 654" None
215084 510 | 150.535 | Mone -
< >
Row: {4 4 |1 of52 | b Wl
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7) Right click on the left bar/column and choose ‘Selection > Create Selection Set.’

'9 Survey Details

=] Element List %% Message Center

Ji Name Morthing Easting Elevation Field Code Link Code Description ™
3 GBDDEH 215203420 [
GE0002 | 215155.004'

Edit selected items. 4

g
Ol View 4 | |
| A Selection 4 | #A  Create selection set.
u  Export selected itemns... b | @ Select from selection set.
A Create Control Points from selected items. 25 Emphasize selected items.
Edit Observations o De-emphasize all.

) Mediafiles
«"  Report on selected items,

Delete selected items.

Reset Details

Verify in the ORD/OSD Selection Set box along the lower right edge of the application, that you
have objects selected. The value in the bottom row of the survey details and the Selection Set
box should match.

—Flet®uu A /O (st o
| 2| @ oetut v2) | | | 2% |=] |

8) Select Terrain > Analysis > Points > Analyze Elevation

NOTE: You must have an active Terrain and it must be visible to allow for selection of the Terrain
to perform the following steps.

=l survey ol e o = K % Workflow MenuPopUp 5 CAODOT\CONNECT Projects\Worksets\ODOT\dgn\K_07961_1
Home Field Book Analyze Edit Geometry Drawing Production Drawing View
=4 e & From File o0 ﬁ% By, Edit Complex Model (I .¢_¢. S A ‘@
= .‘ - o »@ & 434 oo & 7 8 ¢
(8] - =5| From Graphical Filter B g - ﬁi Feature Management % 3 M o
T Element ., Additional Active  Edit : Transform | Points §calculate Volumes Hydraulic Rep
@ Selection L1 * A& From Elements Methods " Model £1 Boundary Options = - Avea v v
Prirmary Selection Create Edit 2% Analyze Between Points
Explorer > ix :
g W View 1 - Top, Default 2. Analyze Point
File v e éE s vl 1l 0000 <t N iw B Analyze Elevation
¥ Items L e .
6% Eleriisit Selectivn o 5 — Inverse Paints
| OpenRoads Model L
2 Sheet Index v :
T Links v
| OpenRoads Standards v
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9) Follow the screen prompts in the ORD status bar at the lower left edge of the application to:
a. ‘Select Terrain’

w View 1 - Top, Default

w-d PPROAD HSREE &Y

6('2,\

Enter Tolerance Value 0.100

b.

c. ‘Enter Tolerance Value’

w View 1 - Top, Default
=Rl Wl B OO

6@.\

Enter Tolerance Value [0.100

Oad|hezoa| s

Enter Tolerance Value
% Enter Tolerance Value
e 2

NOTE: The value entered here is not critical since the tolerances will be set by the report
process, using a general value of 0.10" works.
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10) Once the Bentley Civil Report Browser opens, expand the ‘Custom’ folder in the upper left
portion of the dialog and choose ‘ODOTTerr_ConfPnt_Report_ HTML.xsl’ for the report.

E Bentley Civ

Report Browser - C:\|

File Tools

ppDatsiLo

ODOTTerr_GradeVerification_Report_HTMLxs| Summary
Cant . Surfaced Points | Graded Points | Natural Points | Rugged Points
C!v!l Terrain TOL=0.1 TOL=0.3 TOL= 0.6 TOL=1.5
E!V!:‘SE‘”"E"Y Total Points 28 4 7 3
vilaurvey N n
CorridorModeling Valid Points 25 14 7 3
Evaluation Pass 22 " 6 2
CrossSectionGradebaok.s! Fail 3 3 1 1
CrossSectionGradebookfromCLuxs| Fail 3x 1 0 i] 0
CrassSectionGradebookNExs| %Pass 88% 78.57% 85.71% 66.67%
CrossSectionGradebookWidexsl n
EarthworkQuantities.xsl HFail 3 1% 0% 0% 0%
ElementsComponentQuantitiesReport.xsl Total Number of Confidence Points = 52
ElementsComponentQuantitiesReportSummary.xsl Total Number of Valid Points = 49
EndAreaVolumexs]
MassHaulTaTIW xsl
Pcnd\-'.a.lume.xsl Pnt No Northing Easting PntElev | TM Elev |[TM Delta Result
Quantities by Named Boundary Reportusl G60001 | 215203 4195 | 1851850017 | 194405 | Extemal | None |OFF _SURFACE Surv.
2;9::3:::::::.z:':e;”::fe"°“xs' G60002 | 2151550039 | 185181.0726 | 193875 | 193880 | 0.007 PASS Surv_Ce
T G60003 | 215164 9457 | 1851924076 | 194730 | 194.737 | 0.007 PASS Surv_Ct
Volumes.xsl G60005 | 2151256725 | 185170.2576 | 193.419 193.376 0.041 PASS Surv_Cr
LegalDescription GG0006 | 215104.5095 | 185154.5476 193.216 193.275 -0.059 PASS Surv_Cr
M_EF_'ChECk GG0007 | 215102.4864 | 185114.1323 192.178 192.236 -0.058 PASS Surv_Ci
gﬂ:ll(lggut G60008 | 215053.8232 | 185094.2693 190.750 190.803 -0.053 PASS Surv_Ci
StationOffset G60009 | 215036.9500 | 185082.7095 191.331 191.442 -0.112 PASS Surv_Ce
Superelevation G60010 | 215069.4898 | 185080.2127 | 192.106 | 192.231 | 0.125 PASS Surv_Cc
TemplateLibrary G60011 | 215096.8994 | 185081.9691 193.654 192.299 1.355 FAIL Surv_C
Turnouts G60012 | 215084.5103 | 185112.3469 | 190.535 190.711 -0.176 PASS Surv_Cc
Tools G60013 | 215043.8465 | 185115.1108 | 188.305 188.285 0.020 PASS Surv Con
11) Select File > Save As and choose the Web Page (*.html) option.
E Bentley Civil Report Browser - C:\Users\hwye96r\AppData‘Local\Temp\RPT3vxnmkg2.xml
Tools
Open | |
Save As ¥ Report (*xml)
Append [ [ web page ¢-htmi) e|
i Microsoft Word (*.doc)
Print
Microsoft Excel (*.xlsx) Terrain Name -
Exit ASCI|Text (*txt) Terrain Last Modified -
ODOT Terr_Confi
ODOTTerr_GradeVerification_Out_Txt.sl
CDOTTerr_GradeVerification_Report_HTMLxs!
b Cant Surfaci
I Civil Terrain TOI
Page | 8

|‘ Custom I
rwDesc_HwyCLxs!

ODOTrwDesc_LINE.xs]
CODOTrwDesc_TRACT.xsl
CODOTrwDesc_ WIDTHxs|
ODOTrwDesc_WIDTH_NAMED.xs|
ODOTTerrainCheck xsl

QROTTerr ConfPnt Qut Tutxs]

[ opoTTern_confent Report HTMLusI

QDOT Terr_GradeVernfication_Out_Ixt.xsl

Terrain Name

Terrain Last Modified -

ODOT Terrain Confidence Point Report v2024

Report Created: Wednesday, May 13, 2026
Time: 5:02:54 PM

- MatLab_0G

2026-05-12T21:53:00.946-07:00

May 2026




12) In the Save As dialog navigate to the correct folder in your Project work area, name the file
‘Kit#t##t_NAM_ConfPnt_Report_01’ (K###it#H = project key number & NAM = terrain name or
identifier), confirm that the ‘Save as type:’ is set to HTML File (*.html), and click the ‘Save’

button.

NOTE: The ‘01’ in the file name is a counter and should be incremented each time the terrain or

points are updated during the iterative Confidence Point process.

| E save As >
£« ~ I <« Windows (C:) » WORK » RHQ_ Help » Training_Sites » Matlab I° ~ ] Search MatLab R
Organize *  Mew folder - 9
~

Data Name Date modified Type Size

Work Mo items match your search.

Workflow_Doc

ScreenShots
~ [l This PC

‘ > B Windows (C) ‘

> mm hwyed6r (\wpdotfillD9\R_VMP3_USI

> 3 Network

QG_ConfPnt_Report_01

Save as type:  HTML File (".html)

~ Hide Folders

13) Still in the Bentley Civil Report Browser and the ‘Custom’ folder, choose
‘ODOTTerr_ConfPnt_Out_Txt.xsl’ for the processed point file.
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Cancel

DOTwDese_ HunyCLas! Pnt,N,E, EL, CODE,ATT=TMELEV,ATT=TMDELTA v2024
- ; G60001,215203.4195,185185.8017,194. 4843, CPS, TMELEV=External ,RESULT=0FF_SURFACE
0DQTrwDese LINExs| G60002,215155.8039,185181.08726, 193 . 8728, CPSP, TMELEV=193 . 888, TMDELTA=-8. 007
ODOTrwDesc_TRACT.xsl 660003 ,215164.9457,185192.4876,194. 7308, CPSP, TMELEV=194.737,, TMDELTA
ODOTrwDesc_WIDTH.xs| G600@5,215125.6725,185170. 2576, 1934194, CPSP, TMELEV=193. 378, TMDELTA=0. 841
ODOTrwDesc WIDTH_NAMED.xsl GEAEEE, 215164 .5095,185154.5476,193. 2159, CPSP, TMELEV=193. 275, TMDELTA=
ODOTTerrainCheck.xs| GEPA7,215102.4864,185114.1323,192.1778,CPSP, TMELEV=192.236, TMDELTA=
|__opoTTerr_ConfPnt_Out Ttss! | G60008,215053.8232,185094. 2693,198., 7496, CPSP, TMELEV=19@. 803 , TMDELTA=
=7 Contont_Report. x5l GBGOAT, 215036.9500, 185082 . 7095 ,191 . 3385, CPNP, TMELEV=191.442, TMDELTA=
ODOTTerr_GradeVerification_Cut_Txtxs| G60018,215069 .4898,185080.2127,192.,1057 , CPNP, TMELEV=192.231, TMDELTA=-8.
ODOTTerr_GradeVerification_Report_ HTMLasl G60011,215096.8994,185081.9691,193 . 6541, CPNF, TMELEV=192. 299, TMDELTA=1. 355
I Cant GBGE12,215084.5103,185112.3468,198. 5352, CPNP, TMELEV=19@.711, TMDELTA=
I Civil Terrain G60013,215043.8465,185115.1108,185. 3048, (PGP, TMELEV=188. 285, TMDELTA=0.020
b CivilGeometry G60015,215136.6157,185082.5696,192 . 4552, CPSP, TMELEV=192. 537, TMDELTA=-8. 882
b Civilsurvey GBBA16,215148.7674,185894 . 1947,193 . 8854, CPSP, TMELEV=193 . 887, TMDELTA=-8. 882
I CorridorModeling G60017,21516@.8278,185891.8053,192.1355,CPS, TMELEV=External ,RESULT=0FF_SURFACE
4 Eveluation GB0018,215159.2857,185104.6173,191. 8328, CPS, TMELEV=External ,RESULT=0FF_SURFACE
: GBGA19,215692 .5884,1851408.2792,192 . 3746, CPGF, TMELEV=191.935, TMDELTA=0. 440
CrossSectionGradebook.xs| G60020, 215086 .6906,185204 ., 3693,192. 6959, CPGP, TMELEV=192.713, TMDELTA=-8. 0817
Cross3ectionGradebookfromCLuxs| GE@e21,215097.2246,185224 . 2538, 193 . 8181, CPSP, TMELEV=193. 883, TMDELTA=0.815
CrassSectionGradebookNE xs| G68822,215877 .4556,185256.9574,193 . 5604, CPSP, TMELEV=193. 586, TMDELTA=8 . 864
CrassSectionGradebookWide.xs| G60O23,215083.4332,185293.4343,194, 1349, CPSP, TMELEV=194. 159, TMDELTA=-8. 024
EarthworkQuantitizs.xs GB0024,215063.0234,185304.7215,193. 9745, CPGP, TMELEV=193. 938, TMDELTA=0.837
ElementsComponentQuantitiesRepart.xs| GBBA25,215646.1197,185311.7267,195. 3127, CPGF, TMELEV=194. 535, TMDELTA=@ . 777
ElementsComponentQuantitiesReportSummaryxsl | G66@26,215062.5623,185330.9975,193. 2839, CPGP, TMELEV=193. 455, TMDELTA=-8.171
EndAreaVolume.xs! GB0027,215072.2911,185348 . 6624,194. 2283, CPSP, TMELEV=194. 264, TMDELTA=-0.036
MassHaulToTIW.xsl GBBA28, 215866 .2898,185390 . 2855,194 .. 1998, CPSP, TMELEV=194.. 238, TMDELTA=-8. 839
PondVolumeuxs! G60029,215046.90822,185401.8796,192. 7674, CPGP, TMELEV=192. 659, TMDELTA=0. 048
Quantities by Named Boundary Reportxcs! GB0O38,215037.60826,185444 ,8237,192., 4884, CPGP, TMELEV=192.
SightVisitilityAlternateReportaxs GE0O31,215049.4204,185468.1919,193. 7875, CPSP, TMELEV=193. .
SightVisibilityRepertcl G60032,215029.7515,185489 . 5850,192 . 3453, CPRP, TMELEV=192. 427, TMDELTA=-8. 882
TewainCheckosl GB0O33,215023.5338,185517.8373,191. 7188, CPRP, TMELEV=192. 223, TMDELTA=-8. 585
Volumes.xal G60O34,215040.6261,185541.6929,194. 8169, CPRF, TMELEV=193. 362, TMDELTA=1.5@9
| LegalDescrt; G60035,215048.8192,185517 . 9648,193 . 4634, CPSP, TMELEV=193. 528, TMDELTA=-8. 665
=galDescription GER836,215871.7367,185487.8877,193.5693,CPSP, TMELEV=193. 663, TMDELTA=-8. 093
" MapCheck GE0@37,215064.4192,185446.4555,193.5723, CPSP, TMELEV=193. 932, TMDELTA=-0. 068
I Milling G60039,215086.2306,185452.5727,196. 1563, CPNP, TMELEV=196.. 148, TMDELTA=0. 6GS
I Stakeout G66048,215091.9518,185426.4914,196. 8352, CPNP, TMELEV=196. 742, TMDELTA-0. 894
I StationOffset G60O41,215096.6181,185400.6617,196. 0169, CPNP, TMELEV=195. 999, TMDELTA=0.817
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14) Select File > Save As and choose the ASCII/Text (*.txt) option.

Append

Print

Exat

m Bentley Civil Report Browser - C\Users\hwye96r\AppData\Local\Temp\RPTmh3dxmj:

Pnt,MN,E,EL,CODE,ATT:

Report (*.xml)
Web Page (*.html)

Microsoft Word (*.doc)

Microsoft Excel (*.xlsx)

CODOTTerr_Con

I Cant
I Civil Terrain

[ [ | ascimext ey
.

ODOTTerr_GradeVerification_Out_Tetxs|
ODOTTerr_GradeVerification_Report_HTMLxsl

60881,215283.41595,1
60882,215155.8039,1
60803,215164.9457,1
60885,215125.6725,1
160886,215184 .5895,1
60887 ,215182.4864,]
168888,215853.8232,1
169889,215836.9508, 1
G6081e,215869.48938,]
GEeeell,215096.8994,]
G&0a12,215884.5183,1
GE0813,215843.8465,1

15) In the Save As dialog navigate to the correct folder in your Project work area, name the file
‘Kt NAM_ConfPnt_Processed 01’ (K#t##t = project key number & NAM = terrain name or
identifier), confirm that the ‘Save as type:’ is set to ASCIl/Text File (*.txt), and click the ‘Save’

button.
| m Save As
B « Windows (C:) > WORK » RHQ_Help » Training Sites » Matlab Io v G Search MatLab
Organize *  Mew folder
~
Work Name Date modified Type Size
Workflow Doc |5 Mat_Lab_CTLxt 3/12/2019 2:08 PM Text Document
ScreenShots
~ [l This PC

‘ > %S Windows (C)

> = hwyedér (wpdotfillOsR_VMP3_US|

> Network

OG_ConfP_Processed 01

Save as type:  ASCII/Text File (".bxt)

[
4
-]

 Hide Folders

o Save

Cancel

16) Close the Bentley Civil Report Browser and clear the selection set in ORD/OSD.
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B — Importing the processed data into the Terrain file for analysis.

1) With the Active Terrain file or a Working Analysis file open in ORD/OSD, choose Field Book >

2)

Create > New Field Book.

Bl survey S HE R - -
Home Analyze Edit
Q [-/] Ay Reset Details k ‘\J

Explorer Details

Terrain

Element -, MNew
Selection i... ™ [JField Book

Prirnary Selection

& =2 k% Workflow Me

Geometry Drawi
B S 5

X
Delete  Mew File

Create

Field Book Point

W View 1- Top,

Follow the onscreen prompts to create the new Field Book for importing the Processed
Confidence Point Data, enter a name for the Field Book of ‘Conf_Pnt_Processed’.

' . Survey
New -
Q@ P,
Field Book Mame |Corf_Prit_Processed
|5f5m".'-
4 v ] Survey Data
EName - L . 4 v [& Default
| MNew:Field Book Name | [lEare P e
| ! 4 v []] Field Books
b 1w L] Existing Data
I 4 v [f ConfPnt Processed ]
¥ #» Data Files

NOTE: Processed Confidence Point data should not be imported into the same Field Book that
contains the field data that was used to create the terrain. Because the Processed Confidence
Points have been analyzed in relation to a Terrain they are no longer original raw data and need
to be separated from the original raw data. They can be imported into a separate DGN which
can then be referenced into the original Terrain DGN or they can be imported into the original

Terrain DGN but within a separate Field Book.

Choose Field Book > Import > File

- S HE R« -

g _,-.g] l‘ £ Workflow Menu PopUp =

CADDOTMCONNECT_Project:

Field Book Analyze Edit Terrain Geometry Drawing Production Drawing View

Ay Reset Details 1;';? i Q-

¥

Text Trimble Leica Graphics Bentley
izard Link DBX Survey

Elernent ... Mew Delete  New
Selection i..i 7  Field Book Field Book Point
mary Selection Create
- 01w
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4)

Follow the onscreen prompts to:
a. Locate Field Book = Conf_Pnt_Processed

/% loadData —

Field Book -~
Locate Field Book [
Load il

E:ustlng Da1a

Type DataFile

b. When the Select file dialog opens, click the dropdown arrow for the file type selection (box

above the Open & Cancel buttons)

| E select file
T+ <« _Settings Wk > 2026-05_ConfPnt_Workflow > Work - Search Work
Organize » New folder =~- O
@ Music » Narne - Date modified Type Size
3 Videos » Test 5/12/2026 4:44 PM File folder
Data ¥/ 2026_0DOT_ConfPnt_Report_ScriptiAL.d... 026 5:23 PM Microsoft Word D... 19KB
Work D K99999_ConfPnt_Processed_01.txt 5/13/2026 11:26 AM Text Document 4KB
” e K99399_ConfPnt_Report_01.html /2026 11:20 AM Microsoft Edge H... 34KB
ScreenShots
| ODOT_ConfidencePoint_Report_Steps.do... Microsoft Word D... 19KB
2026 | ODOT_ConfidencePoint_Report_Work_v3... Microsoft Word D... 2,508 KB
5_K9999%_CIVL_wrk_01.dgn Bentley MicroStati... 260 KB
~ . This PC 5_K9999% TERR_e_pub_01.dgn Bentley MicroStati... 476 KB
@ Test_PW_SaveAshtml Microsoft Edge H... KB
| 5 m hwryeS6r (Wwpdotf D Test_PW_SaveText.bxt Text Document 4KB
File name: ‘ Vi All Files (%)
Open Cancel

Select/choose the ‘TIW Oregon DOT TXT File - Conf Pnt Processed (*.txt)’ option from the

list. This will load the correct text import format file and filter the displayed files in the file

folder for the correct extension.

TIW Comma del|m|ted PtNumNF_ZCUde File (*txt:*.cor)

TIW Comma delimited PtNumMEZCodeCode File (*.tct;*.cor)
TIW Comma delimited PtMumXYZCode File (*.tet:*.cor)

TIW Mikon File (*.mwd)

3
TIW Oregon DOT TXT File - GradeVer Pnt Processed (*.ct)
TIW Space delimited PtNumMNEZCode File (* txt;".cor)
TIW Space delimited PtNumXYZCode File ("t " .cor)
TIW Space or Comma delimited XYZ File ("t *.cor)
TIW Tepcon FC4 File (*.fcd)
Tepcomm Mining File (*.top)
Tepcon MaxXML File (".mx[acml)
Tepograph COR File (*.cor)
Topograph MED File (*.med)
Trimble DC SDR File (*.dc:*.=dr)
Trimble Link Engine File [* job)
Tripod Data Systerns TDS File (*.rw3;*.raw)
All Files (*.%)

May 2026
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d. Navigate to the folder where the report and processed files were Saved, select the
‘Kt _NAM_ConfPnt_Processed_01.txt’ file, and click the ‘Open’ button.

[ 7]
€ - T <« WORK » RHOQ_Help » Training_Sites > MatLab ~ & Search MatLab o
Organize + Mew folder = - [ o
13 Music MName - Date modified Type Size
3 Videos I K99399_0OG_ConfPnt_Processed_07.txt l /2026 4:58 PM Text Document 4KB
Data Mat_Lab_CTL.tt 3/12/2019 2:08 PM Text Document 1KB
Work
ScreenShots
2026
v [l This PC
S Windows (C:)
o= hwyeStr (Mwpdotf
File name: | K99899_0G_ConfPnt_Processed_07.bt ~ |  TIW Oregon DOT TXT File - Cor ~
@

» The processed Confidence Points will be imported into the Field Book and displayed in the
DGN with the corresponding symbology. Along with the proper symbols and colors, text
labels will be added to all points, displaying the point ID and the terrain delta value.
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5)

<

Review the report and processed graphics in the DGN to identify failing or problem areas in
the Terrain.

Summary
Surfaced Points Graded Points Natural Points Rugged Points
TOL=0.1 TOL=0.3 TOL=0.6 TOL=1.5
Total Points 28 14 7 3
Valid Points 25 14 7 3
Pass 22 11 6 2
Fail 3 3 1 1
| Fail 3x 1 | 0 0 0
YePass WA 78.57% 85.71% 66.67%
YoFail 3x 4% 0% 0% 0%
Total Number of Confidence Points = 52
Total Number of Valid Points = 49
60049 215121.3102 1852653724 194.724 194.949 -0.2 PASS Surv_Conf Pt Graded_Pass
'GGUOSD 215116.9280 185252 6912 193.943 194 495 -0.552 FAIL Surv_Conf_Pt_Graded_Fail
GE0051 215103.8373 185249 8886 193.852 193.933 -0.081 PASS Surv_Conf Pt Surf Pass
) 215103 1918 186215 E26T 193 766G 193794 0029 PASS Sury Coof Bt Surf Pass
G60053 215121.0126 185205.8482 151.995 193.550 -1.554 FAIL3X Surv_Conf Pt Surf Fail3X ]
—anaay ST FREEIEEEST e R =i=rav PEEs T CanFoGmaTi—rase
G60055 215134.7694 185224 4583 155.088 195.033 0.055 PASS Surv_Conf Pt Graded Pass

After correcting any issues with the Field Book data and Terrain, re-run the ODOT
Confidence Report analysis starting at step A.3 to process the Original Confidence Points
against the updated Terrain. Make sure to increment the names on your report and
processed files so that your results and edits can be saved to document the project process.

May 2026

MatLab X + =
&« I (G (] WORK » RHQ_Help > Training_Sites » Matlab Search Matlab Q
@ New % © )] & 0} T sort = view (B Details
2 Home Mame Date modified Type
=| K99998_0G_ConfPnt_Processed_02.txt Text Document 4KB
) Gallery
L K99999_0G_ConfPnt_Report_02.html Microsoft Edge H... 31 KB
> @b Kevin - Oregon Department of Trar
=| K99999_0G_ConfPnt_Processed 01t Text Document 4KB
L K99999_0G_ConfPnt_Report_01.html Microsoft Edge H... 3 KB
¥ Downloads I Mat Lab Class_CAD.dxf Autodesk Design 290 KB
= hwyed6r [ Mst Lab OGxml 3/12/2019 214 PM XML File 50 KB
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Terrain Name -

Terrain Last Modified -

ODOT Terrain Confidence Point Report v2024

Report Created: Monday, May 18, 2026
Time: 3:16:20 PM

MatLab_0G
2026-05-12T21:53:00.946-07:00

Summary
Surfaced Points Graded Points Natural Points Rugged Points
TOL=0.1 TOL=0.3 TOL= 0.6 TOL=1.5
Total Points 24 14 7 3
Valid Points 24 14 7 3
Pass 22 1 6 2
Fail 2 3 1 1
—
Fail 3x 0 0 0 0
“oPass 51670 78.57 0 82/ 1% bb.6 /%
YeFail 3x 0% 0% 0% 0%

Total Number of Confidence Points = 48
Total Number of Valid Points = 43

When processing additional Confidence Point results and importing the points into the original
Terrain DGN, additional ‘Conf_Pnt_Processed XX’ Field Books can be created with incrementing
numbers to match the Confidence Point file names. Alternatively, the data file which was
imported for the previous results can be deleted from the ‘Conf_Pnt_Processed’ Field Book
before importing the new file into the existing ‘Conf_Pnt_Processed’ Field Book.

4 & I Survey Data
[El Default
[ Field Books

b

i v
PR
4 Existing_Data
> -] Conf_Pnt_Processed
] Conf_Pnt_Processed_02 I
. % Data Files

4

/ \
/G6005 3\

\ 0.06

¥ 74 ALL Point Features
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C — Differences in File Dialog Display with ProjectWise.

When working with a DGN in the ProjectWise (PW) environment, file dialogs (Load & Save) will
appear differently and function differently from the default Windows 11 dialogs. To use the
Windows 11 dialogs, you must ‘Cancel’ the PW dialog/dialogs.

It is recommended that all file loads and saves for the Confidence Point Process use the Windows 11
dialogs. And that all Point Data Files (*.csv), Report Files (*.html), and Processed Point Files (*.txt)
be stored on a non-PW drive, i.e. Local C: drive or other crew server share.

The following images will show examples of the PW file dialogs, how they change with the ‘Cancel’
button, and how many ‘Cancel’ commands are needed before the Windows 11 dialog appears.

1) Import/Load Survey Point Data File (*.csv)
a. The first dialog that appears is the full PW dialog. You are only able to select files from the
PW Environment and there is no option to select a File Type filter or Text Import Wizard
Template. Select ‘Cancel’ to close this dialog and move to the second.

Select file K
Select

Documents
Falder ‘ [ survey ~ | BlEEAa

# e >
MName Description State
Enter text here F| Enter text here *F| Enter text h... |
ms_KSSSES_CIVL_XXX_wrk_m.dgn Deme - Survey Civil Data Working - Existing Topo Field Files Draft
mS_KESSBE_CIVL_XXX_er_DZ.dgn Demo - Survey Civil Data Working - Point Cloud Mapping Draft
/ﬂS_KSSSES_CIVL_XXX_wrk_Dldgn Deme - Survey Civil Data Working - 2D Mapping Draft
[/‘ﬂS_KESSBE_CIVL_XXX_er_M.dgn Demo - Survey Civil Data Working - Add Request 221113 Draft
MS_KSSSES_FEAT_E_pub_DZ «<Marme> - Survey Features Published - Existing Features Mot Inclu..  Draft
;’j 5_KB82888_FldDoc_01.csv Survey Field - Document MatlLab OG Points Data Draft
/j S_K28288_FldDoc_02.csv Survey Field - Document MatLab OG Confidence Points Raw Draft

Application: All Applications ~

Add Remove

Selected Documents
Mame Description State
Enter text here r| Enter text here “F| Enter text h... | Enter text here

OK Cancel
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The second dialog that appears is a PW dialog but with an old Windows 7 look. You can
select files from any local or mapped drive but there is no option to select a File Type filter
or Text Import Wizard Template. The *.csv can be loaded from here and it will import
properly but there is no way to filter the files displayed in the selected folder. Select
‘Cancel’ to close this dialog and move to the third.

E Select file - CAWORK\ORD_Test\_Settings WI\2026 onfPnt_Workflow\Warlk,
Look in' | = Wark v @@ B E- B [E3]
A Name - Date modified Type Size
Test 5/12/2026 444 PM File folder
Home | 2026 ODOT_ConfPnt_Report_ScriptkAL.doox  8/26/2021 443 PM Microsoft Word D... 18K
‘ d K98359%_ConfPnt_Processed_01.bd 5/13/2026 11:26 AM Text Document 4K
L K99999_ConfPnt_Report_01.html 5/13/2026 11:20 AM Microsoft Edge H... 34K
Desktop @t ODOT_ConfidencePoint_Report_Steps.docx 5/12/2026 5:47 PM Microsoft Word D... 19K
@t ODOT_ConfidencePoint_Report_Work_v3.do.. 5/12/2026 5:34 PM Microsoft Word D... 2559 K
5_K99999_CIVL_wrk_D1.dgn 5/13/2026 1:24 PM Bentley Micro5tati... 260 K
Libraries S,KBBDDB,TERR,e,pub,D'I.dgn 5/13/2026 11:35 AM Bentley MicroStati... 496 K
This PC
Network
File name: v | Done
Files of type Al Files (%) ~ I Cancel I_
" Options

The third dialog that appears is the Windows 11 dialog. You can select files from any local or
mapped drive, and you can select a File Type filter or Text Import Wizard Template. Select
the *.csv file and then select ‘Open’ to load the data into the DGN.

| Bl select file * |
™ <« WORK > ORD_Test »> _Settings Wk » 2026-05_ConfPnt Workflow > Data v G Search Data »p
Organize v Mew folder = - (] o
MName Date modified Type Size
“ Videos ¥P
Data [ ||33_-/ MatLab_ConfPnt_Orig.csv 12/31/2020 12:47 PM Microsoft Excel C... 3 KB‘ ]
Work [ 5_K88888_FldDoc_01.csv 5/13/2026 1:39 PM Microsoft Excel C... 41 KB
o) SF_ASC TestMatlab_Test/PT.cov 5/12/2026 11:51 AM Microsoft Excel C... 41 KB
Workflow_Doc
[/ SF_ASC_TestMatLab_Test)PT_MIXED.csv 5/12/2026 10:31 AM Microsoft Excel C... 35KB
ScreenShots
| v [ ThisPC

| » s Windows (C)
I

> e hwyeSr (\wp

| > Network

File name: | MatLab_ConfPnt_Orig.csv ~ | AllFiles (~%) ~
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2) Import/Load Processed Point Data File (*.txt)
The first dialog that appears is the full PW dialog. You are only able to select files from the
PW Environment and there is no option to select a File Type filter or Text Import Wizard

a.

May 2026

Template. Select ‘Cancel’ to close this dialog and move to the second.

Select file
Select

Documents
Foider | (17 Survey Jepl EEIR

e -|»
Mame Description State
Enter text here | Enter text here | Enter text h... |
mS_KESSES_CIVL_XXX_wrk_m.dgn Dema - Survey Civil Data Working - Existing Topo Field Files Draft
mSJ(BSSBE?CIVLﬁXXXﬁerﬁDl.dgn Demo - Survey Civil Data Working - Point Cloud Mapping Draft
mS_KESSES_CIVL_XXX_er_D}.dgn Dema - Survey Civil Data Working - 2D Mapping Draft
mSJ(BSSBE?CIVLﬁXXXﬁerﬁDd.dgn Demeo - Survey Civil Data Working - Add Request 221113 Draft
/ NJS_KESSES_CP_E_M bt Survey Surface QC - Confidence Point Analysis, MatLab OG Proces...  Draft
msﬁKB&&BSﬁFEATjipubiDZ <Mame> - Survey Features Published - Existing Features Not Inclu...  Draft
/j 5_K88288 FldDoc_01.csv Survey Field - Document MatlLab OG Points Data Draft

Application: All Applications ~

Add Remove

Selected Documents
Mame Description State
Enter text here T| Enter text here F| Entertest h... F| Enter text here
La jSﬁKBS&BEﬁCPJﬁN ot Survey Surface QC - Confidence Point Analysis, MatLab OG Proces... Draft 5/13/20:

0K Cancel

If you do have a *.txt in the PW Environment and select it to load, then a secondary dialog
will pop up, allowing you to select the correct Text Import Wizard (TIW) template. Select

the TIW template and then select ‘Apply’ to complete the import process.

TIW Comma delimited PtNumNEZCode File
TIW Comma delimited PtNumNEZCodeCode File
L oo d i ade Fil=

TIW Space delimited PtNumNEZCode File
TIW Space delimited PtNumXYZCode File

L V1O LYRL] #]a]
TIW Cregon DOT TXT File - GradeVer Prit Processed
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The second dialog that appears is a PW dialog but with an old Windows 7 look. You can
select files from any local or mapped drive but there is no option to select a File Type filter

or Text Import Wizard Template.

Select ‘Cancel’ to close this dialog and move to the third.

E Select file - CAWORKAORD_Test\_Setting onfPnt_Workflo Vorld,
Lookin: [ = Wark v @%@ E &
/\ Mame Date modified Type Size
Test 5/12/2026 4:44 PM File folder
Home | 2026 ODOT_ConfPnt_Report_ScriptkAL.docx  8/26/2021 443 PM Microsoft Word D... 18K
‘ | =] K99999_ConfPnt_Processed_01.txt 5/13/2026 11:26 AM Text Document 4K
e K%999%_ConfPnt_Report_01.html 5/13/2026 11:20 AM Microsoft Edge H... MK
Desktop @t ODOT_ConfidencePoint_Report_Steps.docx 5/12/2026 5:47 PM Microsoft Word D... 19K
¥ ODOT_ConfidencePoint_Report_Werk_v3.do..  5/12/2026 5:34 PM Microsoft Word D... 2,559 K
5_K99999_CIVL_wrk_01.dgn 5/13/2026 1:24 PM Bentley MicroStati.., 260K
Libraries S_KDQDDD_TERR_e_pub_m.dgn 5/13/2026 11:35 AM Bentley Micro5tati... 496 K
This PC
Network
File name K95955_ConfPnt_Processed_01 bt ~ | Done
Files of type Al Files (%) v I Cancel I_
L Options

If you select a *.txt file to load, then a secondary dialog will pop up, allowing you to select
the correct Text Import Wizard (TIW) template. Select the TIW template and then select
‘Apply’ to complete the import process.

L V1O LYRL] #]a]
TIW Cregon DOT TXT File - GradeVer Prit Processed
TIW Space delimited PtNumNEZCode File
TIW Space delimited PtNumXYZCode File

TIW Comma delimited PtNumNEZCode File
TIW Comma delimited PtNumNEZCodeCode File
i y nde Eils
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e. The third dialog that appears is the Windows 11 dialog. You can select files from any local or
mapped drive, and you can select a File Type filter or Text Import Wizard Template. Select
File Type filter drop down, choose the correct TIW Template, select the *.txt file, and select
‘Open’ to load the data into the DGN.

Land XML File (*xml)

Leica Digital Levels File (*.gsi:*.lev)
) Leica HeXML (*xml)

<« WORK > ORD_Test » _Settings Wk »> 2026-05_ConfPnt_Workflow > Waork ~ O Leica MDF File [*.mdf)

MX Control File (".inp)

Meutral File (*.xnf)

= SDMS CAL File (*.cal)
Mame - Date modified Type Size zgmg E);JCFTLE(ET;SC]
Test 5/12/2026 4:44 PM File folder Ew }é‘;\rSnHrI S dse[m.st:ﬁimﬂﬂrﬂ EZCode File (bt cor)
() 2026 ODOT_ConfPnt_Report_ScriptkALd... 3/13/2026 5:23 P Microsoft Word D... ﬁ:w Eg::: ::::::::: Ezmmg%g;dd:gﬁ:fﬁ‘:ﬁ“”
5] K29999_ConfPnt_Processed_01.b¢t 5/13/2026 11:26 AM Text Docurnent T' Mikon File (*.mwd)

& K99999_ConfPnt_Report_01.html

f13/2026 11:20 AM Microsoft Edge H...

7 :
7 PM Microsoft Word D... TIW Oregon DOT TXT File - GradeVer Pnt Processed (".bd)
TIW Space delimited PtNumNEZCode File (*.bdt;".cor)

ot ODOT_CenfidencePoint_Report_Steps.do...

@* ODOT_ConfidencePoint_Report_Work_v3... 126 9:34 AM Microsoft Word D... 2,3 TIW Space delimited PthNumXYZCode File (*.td;".cor)
TIW Space or Comma delimited XYZ File (*.be;*.cor)
5_K99999_CIVL_wrk_01.dgn 5/13/2026 1:24 PM Bentley Micro5tati... ATIW Topcon FC4 File (*fcd)

P, Tepcomm Mining File (*.top)

2026 1:29 PM Bentley MicroStati... 4 Topcon MaXML File (*.mxl:* xml)
Tepograph COR File (*.cor)

Tepegraph MED File (*.med)

Trimble DC SDR File (*.dc;*.sdr)

Trimble Link Engine File (.job)

Triped Data Systerns TDS File (*.rw5;* raw)

5_K99999_TERR_e_pub_01.dgn

L Test_PW_Saveds.html Microsoft Edge H...

|=| Test PW_SaveText.bet Text Document

ame: | All Files (%)
| Bl select file s
T <« WORK > ORD_Test > _Settings Wk > 2026-05_ConfPnt_Workflow > Work ~ C Search Work =l
Organize v New folder =- 0 ©
~
O Music Mame Date modified Type Size
i3 Videos Test 5/12/2026 444 PM File folder
Data [ ‘ |= K99999_ConfPnt_Processed_01.txt 5/13/2026 11:26 AM Text Document 4 KE| ]e
=] Test_PW_SaveText.bt Text Document 4 KB
Work
ScreenShots
Workflow_Doc
~ [ This PC
> mm hwyedr (\wp
e
File name: [ 99999 ConfPnt_Processed_01.b4 | W Oregon DOT T File - Cor
6 I Open I Cancel

NOTE: If the File Type Filter is not set to a TIW Template before loading the *.txt file the
same pop up dialog shown in (2b) and (2d) above will allow you choose the correct TIW for
the data type.
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3) Save an HTML or Text File
a. The first dialog that appears is the PW Naming Wizard dialog. Select ‘Cancel’ to close this
dialog and move to the second.

! # Select a Wizard * |

Document Creation Wizards

2

‘ No Wizard Advanced

Wizard

[T Make this wizard the defautt choice

b. The second dialog that appears the general PW Save As dialog. It is NOT recommended to
save these files in PW because the naming convention does not allow for a good descriptive
name on these working data files. Select ‘Cancel’ to close this dialog and move to the third.

i General
Folder Save
Discipline specific working area for documents and data Browse. ..
Document
| Mame: 5_K88883_TERR_e_pub_10.html n [/}

Description: 5_K88885_TERR_e_pub_10.html

File Mame: 5_K88B8838_TERR_e_pub_10.html

Format: *html Format...
Application: Department:

Web Page ~ | | <none> ~

c. The third dialog that appears is the Windows 11 dialog. Navigate to the desired folder or
network location. Enter an appropriate name for your file in the ‘File name:’ box. Select
‘Save’ to complete the process.

| El saveas X
‘T‘I <« WORK » ORD_Test » Settings Wk > 2026-05_ConfPnt_Workflow > Work ]o &) Search Work »p
Organize » New folder = - (2]
| Data Marne Date medified ~ Type Size |
|
| Work Test 5/12/2026 4:44 PM File folder
Workflow Doc L K99999_ConfPnt_Report_01.html /13/2026 11:20 AM Microsoft Edge H... 34Ke
ScreenShots
~ [ This PC

| > E Windows (C:)

> hwyed6r (Vwp

| F|\Enarr+ “ le V‘
|

Saveastype: Web Page (*html) vl

File = Directory ~

~ Hide Folders e Cancel
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